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ABSTRACT
This application report provides a design process overview of the bq27505 family of
gas gauges, procedures to use the evaluation module and software, and helpful
troubleshooting techniques.
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The Texas Instruments bq27505 series system-side, Li-ion battery fuel gauge is a microcontroller
peripheral that provides fuel gauging for single-cell, Li-ion battery packs. The device requires little system
microcontroller firmware development. The bq27505 resides on the system main board and manages an
embedded battery (nonremovable) or a removable battery pack.

The bq27505 uses a patented Impedance Track™ algorithm for fuel gauging and provides information
such as remaining battery capacity (mAh), state-of-charge (%), run-time to empty (min), battery voltage
(mV), and temperature (°C).

Battery fuel gauging with the bq27505 requires only PACK+ (P+), PACK– (P–), and Thermistor (T)
connections to a removable battery pack or embedded battery.

TI recommends that you familiarize yourself with these documents before working with the Impedance
Track™ gas gauge devices.
• Single-Cell Impedance Track™ Gas Gauge for Novices application report (SLUA422)
• bq27505EVM System-Side, Single-Cell Impedance Track™ Technology Evaluation Module user's

guide (SLUU356)
• Host-side gas-gauge-system design considerations for single-cell handheld applications technical

article (SLYT285)
• Configuring the bq27505 Data Flash application report (SLUA525)
• bq27505-J2, System-Side Impedance Track™ Gas Gauge data sheet (SLUS924)
• Using bqTester Single Site Software application report (SLUA352)
• Theory and Implementation of Impedance Track Battery Fuel-Gauging Algorithm application report

(SLUA450)
• Going to Production With the bq27505 Family application report (SLUA516)
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1.2 Terminology

1.3 Document Overview

2 Getting Started With the bq27505 Evaluation Module

2.1 Necessary Components

www.ti.com Getting Started With the bq27505 Evaluation Module

Term Description Term Description
DF Data Flash IT Impedance Track™
GG Gas gauge MAC Manufacturer Access Command

Data Flash Image file (binary) with modifiedSENC Firmware file (encrypted) DFI data
EVSW configuration file specific to a gasbqEASY™ bq27505 programming wizard ENCR gauge firmware version

Chemical model files for different LI-ionCHEM EZY bqEASY™ project filebatteries

This document covers procedures for evaluation module setup and working with bqEvaluation Software
(bqEVSW). Additionally, the document highlights multiple approaches to troubleshooting the software
connection, graphical user interface navigation, and key elements for the different configuration windows.

Example step-by-step procedures are described in Section 6 for:
• Choosing the correct chemistry
• Resetting the pack
• Logging data during testing
• Sealing and unsealing a pack

To get started with the bq27505 evaluation module (EVM), perform the following:
1. Gather all needed components.
2. Acquaint yourself with the EVM board, pin descriptions, and basic EVM configuration.
3. Download the bqEVSW.
4. Install the bqEvaluation Software.
5. Install two USB drivers to communicate with the EV2300.
6. Make the circuit module connections.
7. Start the bqEvaluation Software.
8. Become familiar with key Li-Ion battery fuel gauge software procedures.

To perform the bq27505 procedures described in this report, you need:
• bq27505EVM board (HPA386)
• EV2300 USB PC Interface Board
• Four-colored wire set connector (I2C communication from EVM J8 to EV2300)
• USB cable (A-B type)
• NTC103AT Thermistor
• Latest documentation and software from the Texas Instruments Internet site (see www.ti.com)
• PC host running the Windows™ 98SE, Windows XP, or Windows 2000 operating system and an

available USB port
• Power supply or single-cell in series Li-ion battery (Li-ion battery preferred)
• Electronic load or electronic system (range 3 V to 4.2 V)
• Single-cell Li-ion battery charger (optional)
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2.2 bq27505EVM Board and Pin Description
Getting Started With the bq27505 Evaluation Module www.ti.com

Use this section to become familiar with the bq27505EVM module, pin/jumper descriptions, and the basic
EVM configuration.

Figure 1. bq27505 Evaluation Module

Table 1. bq27505 Pin/Jumper Descriptions
PIN NAME / Jumper DESCRIPTION
PACK+ (J2-1 and J3-4) Pack positive terminal
PACK– (J2-4 and J3-1) Pack negative terminal
T (J2-2 and J3-3) Pack thermistor input

Terminal connected to Pack- for making thermistor connectionT- (J2-3) convenient
NC (J3-2) No connect
SDA (J4-3) I2C communication data line
SCL (J4-2) I2C communication clock line

Signal return for communication line; shared with charger andVSS (J4-1) ground
CHARGER+/LOAD+ (J7) Power for load or charger connection
CHARGER–/LOAD– (J6) Ground for load or charger connection (system VSS)
BAT_LOW (J5-3) Access to push-pull output that signals low state-of-charge
BAT_GD (J5-2) Access to open-drain output indicating pack is connected to the EVM
SOC_INT (J5-1) State of Charge Interrupt
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2.3 Download the bq27505 Evaluation Software

2.4 Install bq27505 Evaluation Software

2.5 Install USB Drivers for EV2300 Communication

www.ti.com Getting Started With the bq27505 Evaluation Module

Figure 2. Basic bq27505EVM Configuration

This software can be downloaded from the device product folder or evaluation module product folder (use
the keyword bq27505 as the Search by Part Number keyword) from www.ti.com. Follow search result links
to the corresponding product folders.

Note: Before installing the bq27505EVM software, ensure that the EV2300 communication box is
disconnected from the PC Host.

Using the zip file you downloaded from the TI Internet site:
1. Unzip the SLUC155.zip file to a temporary directory.
2. In your temporary directory, browse for the preliminary software installation file with the generic name:

bqEV-EASY-HH SWSetup00.XX.yy_bq27505v1.00_bqEasyvz.zz.exe, where XX=major preliminary
number, yy=minor preliminary number, and z.zz= version number.

3. Double-click and follow the standard installation instructions; accept license agreement, choose folder,
and display Readme file.

Note: Before installing the USB drivers, use the supplied USB cable to connect the EV2300 to the
computer that has the bq27505 evaluation software installed.

Installing the driver for the EV2300 communication box requires you to install two USB drivers for proper
operation. Complete instructions for installing the USB drivers can be found in the EV2300 Driver to USB
Port Association section of the Using bqTester Single Site Software document (SLUA352).

Briefly, the required steps are:
1. When the operating system prompts you with a Found New Hardware Wizard, Choose the No, not at

this time option.

SLUA515–August 2009 Quick-Start Guide for the bq27505 Family of Gas Gauges 5
Submit Documentation Feedback

http://www.ti.com
http://www-s.ti.com/sc/techlit/SLUA352
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA515


2.6 EVM Connection Setup

2.7 Starting the bq27505EVM Software

2.8 bqEVSW Software Sections

Getting Started With the bq27505 Evaluation Module www.ti.com

2. On the next screen, select the Install from a list or specific location option and use the Browse button
to navigate to the PC Host folder (XP system): C:\Windows\TI\USB1

3. Respond Continue Anyway to the warning that drivers are not certified by Microsoft.™
You have successfully installed the TI USB Firmware Updater.

4. Once again, the operating system prompts you with a Found New Hardware Wizard, Choose the No,
not at this time option.

5. On the next screen, select the Install from a list or specific location option and use the Browse button
to navigate to the PC Host folder (XP system): C:\Windows\TI\USB2

6. Respond Continue Anyway to the warning that drivers are not certified by Microsoft.
You have successfully installed the TI USB bq27505 Driver.

Refer to Figure 2 when performing the EVM setup:
1. Connect one side of the 4-wire-set connector to the EV2300’s I2C port (black wire aligned with GND

pin) and the other side to the board's J8 connector (black wire aligned with the VSS pin).
2. Ensure that jumper in J4 of board is connected at the bottom position as shown Figure 2.
3. Ensure that NTC103AT thermistor is connected to the T and T– terminals of the J2 block of the board.
4. Ensuring proper polarity, connect the 3-V to 4.2-V power supply or single-cell Li-ion battery between

the PACK+ and PACK– terminals (J2) of the board.
5. To see current measurements, apply a load to J7 and J6 board connectors.

Note: J6 is for host or charger ground and J7 is for host or charger power.

6. To properly configure the fuel gauge IC for a given application, proceed to the bqEASY™ area of the
evaluation software (Section 4.5) and the bq27505 EVM user's guide (SLUU356).

For detailed instructions on operating the fuel gauge system, see the bq27505 data sheet (SLUS924); the
bqEASY™ software, see the bqEASY™ for bq27505 Impedance Track™ Devices user's guide
(SLUU372); and the bq27505EVM System Side Single-Cell Impedance Track™ Technology Evaluation
Module user's guide (SLUU356).

Beginning at the Windows Start menu, start the bq27505 evaluation software by selecting the application
from the cascading menus: Start → Programs → Texas Instruments → bq Evaluation Software. To
become familiar with the bq27505 evaluation module (EVM) you can simulate a battery cell with resistors
and a power supply. You can vary the voltage across these resistors to simulate different states of charge.
This configuration is shown in Figure 2 and described in the bq27505EVM System Side Single-Cell
Impedance Track ™ Technology Evaluation Module application note (SLUU356).

The bq27505 evaluation software uses five major sections (Figure 3):
• DataRAM—standard I2C information you can read from the pack when it is sealed and important IC

status registers.
• Data Flash—shows all the parameters you can change when designing your system. See the data

flash value description found in the Configuring the bq27505 Data Flash (SLUA525) application report.
• I2C Pro—reads and writes data from any I2C-compatible gas gauge, plus can also load a new

firmware file.
• Calibrate—performs temperature, coulomb counter (CC) input, board current, and pack current

calibration tests.
• bqEASY™—software wizard that acts like a workflow to simplify the configuring, chemistry selection,

and performing learning cycles needed to produce the final "golden image" file.
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3 Software Communication and Troubleshooting

www.ti.com Software Communication and Troubleshooting

A Checkbox to Keep Scanning while you make changes.
B Switches you quickly between major software areas.
C Area provides information on Communication status, device type, and firmware version number.

Figure 3. bq27505 EVM Software Organization

When you start the bq27505 EVM software (bqEVSW), it automatically recognizes the firmware and
hardware version. If a EV2300 USB PC Interface board communication problem occurs, the message in
Figure 4 displays.

Figure 4. bqEVSW Unable to Communicate With EV2300

Click OK and the software requests you to choose a device in use. If you get to this point, you are not
going to have proper communication with the EVM.

If you choose one of the devices and firmware revisions, you eventually can display the DataRAM window;
however, key flags and status bits are grayed-out (Figure 5). The bq27505 EVM software uses color
codes to describe the current status for the DataRam Flags and Status bits. Familiarize yourself with the
legend in Figure 3 and Figure 8.

SLUA515–August 2009 Quick-Start Guide for the bq27505 Family of Gas Gauges 7
Submit Documentation Feedback

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA515


3.1 Troubleshooting USB Communication Issues

Software Communication and Troubleshooting www.ti.com

Figure 5. DataRAM Window Displaying No EV2300 Communication

If you are having EVM communication issues, try these steps:

• Do you have the EV2300 USB cable connected (Figure 6) as shown in the Figure 2?
• Have you properly installed the required TI USB Firmware Updater and the TI USB bq27505 drivers,

as discussed in Section 2.5?
• Did you kick-start the EVM by connecting power momentarily to PACK+ and PACK– to simulate a

charger insertion?
• Are the I2C lines connected to the EVM (Figure 2)?
• Is another instance of the software already running? Press Ctrl+Alt+Delete keys to display the Task

Manager, and look for another instance of the bq2750xEVM software (bqEVSW) running.
• Try restarting your computer if you do not see the TI USB bq2750x driver displayed in the System

Properties → Hardware dialog tab → Device Manager window.

Figure 6. bqEVSW Software Shows No USB Board If EV2300 Is Not Connected
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4 bq27505 Evaluation Software Sections

4.1 DataRam Window

www.ti.com bq27505 Evaluation Software Sections

Figure 7. bqEVSW Warns If No EVM or EVM Not Powered Up

The DataRAM screen displays as the default window, providing you access to the context-sensitive help
and the five windows used to organize the software GUI controls:
• DataRAM
• Data Flash
• I2C Pro
• Calibrate
• bqEASY Wizard

If everything is working correctly, a DataRAM window similar to Figure 8 displays with green/orange
indicators in the status registers. Also, Communication OK is in the lower left corner. Click on the Keep
Scanning box at the top of the window. The software continues to update these values throughout your
testing process.

The DataRAM window shows the standard I2C information that you can read from the pack when it is
sealed, or unsealed. The FAS and SS bits in Control Status indicate if the gauge is sealed. By default, the
IC is configured in full access mode.
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bq27505 Evaluation Software Sections www.ti.com

Figure 8. DataRAM Displaying Appropriate Communication With EV2300

You can issue Manufacturer Access commands (MAC) from this window by clicking in the Control field
under the Value column (see Figure 15 ). For example, this issue arises when writing the Unseal or Full
Access commands. Examples of how to complete these processes is included in Section 6.4.
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4.2 Data Flash Window
www.ti.com bq27505 Evaluation Software Sections

The Data Flash window (Figure 9) shows all the parameters you can change when designing your
system. To begin, you can load the default values stored which shows the single cell pack configuration.

Figure 9. Data Flash Screen

For detailed information on configuring the Data Flash for your particular design, see the Configuring the
bq27505 Data Flash application report (SLUA525)—a comprehensive resource for all Data Flash
parameters.

Remembering all the nuances of the Data Flash parameters is impractical. However, all of the Data Flash
definitions are listed in the bq27505 Technical Reference Manual.
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4.3 I2C Pro Window
bq27505 Evaluation Software Sections www.ti.com

The I2C Pro window helps you communicate with bq27505 IC. In this window, you can read and write
byte, word, and block information. Also, you can upload a new .SENC file from this window.

Figure 10. I2C Pro Window
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4.4 Calibrate Window

4.5 bqEASY™ Wizard

www.ti.com bq27505 Evaluation Software Sections

The Calibrate window (Figure 11) helps you calibrate gas gauge voltage, current, temperature, and
offsets.

Figure 11. Calibrate Window

The bqEASY™ window (Figure 12) is a new feature in the bq Evaluation Software, used to program the
Data Flash parameters, choose the proper battery chemistry, and perform the two cycle tests to create
your Golden Image. If you are new to the Impedance Track™ technology, this is a great way to have a
structured workflow to follow. (See details in Section 5.1.)

The bqEASY™ Wizard uses data entry dialogs to gather information and perform production tasks:
1. Setup—Impedance Track Configuration Wizard Splash screen
2. Configure—choose Data Flash parameters

a. Cell Characteristics
b. Charge Parameters
c. Discharge Parameters
d. Reserve Capacity
e. Load Characteristics
f. Application Configuration
g. Remaining Capacity Method
h. Miscellaneous Information

3. Calibrate
a. CC Offset
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5 Creating Your Golden Image

5.1 Production Flow

Creating Your Golden Image www.ti.com

b. Voltage
c. Temperature
d. Pack Current
e. Board Offset
f. Review / Read DFI file

4. Chemistry
a. Use Default Chemistry
b. Select Chemistry Manually
c. Do Chemistry Select Cycling

5. Cycle
a. Learning Cycle
b. Update Golden Pack

Figure 12. bqEASY™ Wizard

One of the major benefits of using the Impedance Track™ technology, aside from the highly accurate gas
gauging, is a simplified manufacturing process. No charge or discharge cycles are required after
assembling the pack, which can take many hours.

Figure 13 is a procedure diagram showing the normal production flow of the bq2750x chipset. A detailed
description of these states can be found in the Going to Production with the bq27505 application report
(SLUA516).
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5.2 Design and Evaluation

5.3 The Gas Gauge File

www.ti.com Creating Your Golden Image

Figure 13. Production Flow Diagram

These are the different steps in design, preproduction, and production.

1. Install the bqEVSW software (Section 2.4) and the EV2300 communication USB drivers (Section 2.5) .
2. Connect resistors and power supply to simulate battery pack.
3. Kick-start the EVM (connect power momentarily to the PACK+ and PACK– to simulate charger

insertion).
4. Start the bqEVSW software
5. Explore the different features of the software.
6. Load the correct .chem file corresponding to the chemistry of your battery cells using the bqEASY™

Wizard (see Section 6.1 ).
7. Program the necessary Data Flash constants specific to your design.
8. Connect a real battery cell to the EVM
9. Fully charge the cells and let reset for 2 hours.
10. Start Data Logging – both DataRAM parameters and the .GG gas gauge files.
11. Repeat these steps as often as necessary:

• Enable the Impedance Track™ algorithm
• Discharge Pack to termination voltage and let reset.
• Repeat this process

12. Look for updated resistances and Update Status = 02 in the final .GG file.
Once you have a properly cycled pack with updated values, you need to create a Golden image file
that is programmed and incorporated into every pack coming off the production line.

13. Export the .GG file and make a few changes (disable IT and change cycle count to 0).
14. Reload the .DFI file to clear out Data Flash hidden values.
15. Import your changed .GG file.
16. Now you are ready to create the .DFI file used to program production packs.

The Gas Gauge (.GG) file stores all programmable Data Flash parameters as well as the updated cell
resistance profile after doing the two cycle tests.
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6 Example Procedures

6.1 Choosing the Correct Chemistry

6.2 Resetting the Pack

Example Procedures www.ti.com

For the Impedance Track™ algorithm to work properly, the exact chemistry of the lithium cells must be
known and the correct .SENC file must be loaded.

The most updated chemistry files can be found installing the latest version of the bqEVSW software
(Section 2.4), which you can find on the TI Internet site in the bq27505 Product folder. The files are stored
in the folder named: C:\Program Files\Texas Instruments\bq Evaluation Software\Plugins\Chemistry The
Chem.ini file describes the chemistry, manufacturer, and model numbers for the *.CHEM files in this
folder.

You can use the bqEASY™ Wizard (Figure 14) to display the chemistry information in an easy-to-use and
organized manner. If you are using the bqEASY™ Wizard, it asks you to choose the correct chemistry
from a list of manufacturers and model numbers. Alternatively, you can test for a compatible chemistry
using a 4 point test.

A unique chemical ID indicates a different battery chemistry being used.

Figure 14. Chemistry Selection Table in bqEASY™ Wizard

Vary the voltage of the power supply (being careful not to exceed maximum voltages), and issue a RESET
Manufacturer Access Command (MAC) to the bq27505. The I2C double-word command is 0x00, data
0x0041.
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6.3 Data Logging

www.ti.com Example Procedures

This can be done in two ways (see Figure 15). The shortcut is to type 41 into the Manufacturer Access
Value of the DataRAM window. Alternatively, use the I2C Pro window to issue a reset command 00, data
4100 from the Write I2C Data Block and click the Write Data button.

Figure 15. Sending MACs - DataRAM and I2C Pro Windows

While you are running your charge and discharge tests, you may want to log the DataRAM and gas gauge
(.GG) flash data. This is done in two steps. The DataRAM data is logged by selecting the File →
Start Logging menu command (Figure 16). The Save As (Log File Name) dialog asks what folder and
what file name to use for the Log File.

Figure 16. DataRAM Data Logging Command

To save the iterations of the Gas Gauge (.GG) file, go to the Data Flash window and select the
Options → Set AutoExport Filename command. A series of Gas Gauge files is created in the folder
specified throughout the testing. You can adjust the save interval of AutoExport (every 15 minutes is
usually acceptable) using the Options → Set Export Interval command. To start the logging, select the
Options → AutoExport command (Figure 17) to begin saving the Gas Gauge files.
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6.4 Seal and Unseal Process

Example Procedures www.ti.com

Figure 17. Gas Gauge Logging Setup and Start Commands

Once you are finished with the production flow (see Figure 13) and have programmed the correct gas
gauge (.gg) file for your Golden Pack, seal the pack. If you do seal the pack, you can issue the Unseal
command, followed by the Full Access command to make changes. However, if you removed power to the
IC, it returns to sealed mode and you have to repeat this process to unseal and subsequently move to full
access mode. The only way to reset the IC to automatically come up in full access mode is to reload the
.SENC file with defaults.

Note: Be careful when reloading the .SENC file as it can erase any Data Flash constants or
resistance updates through cycling that you may have made.

If you Seal your battery pack and later you decide to unseal it (for example, diagnosing a field failure), you
must perform these steps to move from Sealed, to Unsealed, and finally to Full Access mode.
1. During production, change the default Unseal and Full Access Keys settings in the IC. To read the

default Unseal and Full Access Key, the data flash portion of the device needs to be opened by the
configuration file .encr and the Security dialog tab (Figure 18) can be accessed. The default Unseal
Key and Full Access Key can be modified.

2. When the IC is sealed, and you connect the EV2300 and start the bq27505 evaluation software, the
DataRAM window displays as in Figure 19. Sealing the pack is done using Manufacturer Access
0x0020.

Note: Do not seal your pack until after production.

3. The FAS (Full Access Seal mode) and SS (Sealed State) bits are set when the seal command is
issued through the control register. To move from Sealed to Unsealed mode, write to the bq27505
device with the UNSEAL Key. You still need to move from Unsealed to Full Access mode using the
FullAccessKey.

Note: The SS bit (Sealed) is cleared; however the FAS bit (Full Access) is still set in Figure 21.

4. After issuing the two 0xFFFF Full Access Key through control register, the FAS bit (Figure 22) is also
cleared.
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Figure 18. Default Unseal Key and Full Access Key

Figure 19. Sealed Mode for the bqEVSW DataRAM Window
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Figure 20. Default Unseal Command Using Control Register

Figure 21. Status Showing Unsealed Mode With Full Access FAS Bit Set

Figure 22. FAS and SS Bits Are Cleared
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IMPORTANT NOTICE
Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.
TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.
TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.
Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.
TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.
TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.
TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.
Following are URLs where you can obtain information on other Texas Instruments products and application solutions:
Products Applications
Amplifiers amplifier.ti.com Audio www.ti.com/audio
Data Converters dataconverter.ti.com Automotive www.ti.com/automotive
DLP® Products www.dlp.com Broadband www.ti.com/broadband
DSP dsp.ti.com Digital Control www.ti.com/digitalcontrol
Clocks and Timers www.ti.com/clocks Medical www.ti.com/medical
Interface interface.ti.com Military www.ti.com/military
Logic logic.ti.com Optical Networking www.ti.com/opticalnetwork
Power Mgmt power.ti.com Security www.ti.com/security
Microcontrollers microcontroller.ti.com Telephony www.ti.com/telephony
RFID www.ti-rfid.com Video & Imaging www.ti.com/video
RF/IF and ZigBee® Solutions www.ti.com/lprf Wireless www.ti.com/wireless

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2009, Texas Instruments Incorporated

http://amplifier.ti.com
http://www.ti.com/audio
http://dataconverter.ti.com
http://www.ti.com/automotive
http://www.dlp.com
http://www.ti.com/broadband
http://dsp.ti.com
http://www.ti.com/digitalcontrol
http://www.ti.com/clocks
http://www.ti.com/medical
http://interface.ti.com
http://www.ti.com/military
http://logic.ti.com
http://www.ti.com/opticalnetwork
http://power.ti.com
http://www.ti.com/security
http://microcontroller.ti.com
http://www.ti.com/telephony
http://www.ti-rfid.com
http://www.ti.com/video
http://www.ti.com/lprf
http://www.ti.com/wireless

	1 Introduction
	1.1 Related Documentation
	1.2 Terminology
	1.3 Document Overview

	2 Getting Started With the bq27505 Evaluation Module
	2.1 Necessary Components
	2.2 bq27505EVM Board and Pin Description
	2.3 Download the bq27505 Evaluation Software
	2.4 Install bq27505 Evaluation Software
	2.5 Install USB Drivers for EV2300 Communication
	2.6 EVM Connection Setup
	2.7 Starting the bq27505EVM Software
	2.8 bqEVSW Software Sections

	3 Software Communication and Troubleshooting
	3.1 Troubleshooting USB Communication Issues

	4 bq27505 Evaluation Software Sections
	4.1 DataRam Window
	4.2 Data Flash Window
	4.3 I2C Pro Window
	4.4 Calibrate Window
	4.5 bqEASY Wizard

	5 Creating Your Golden Image
	5.1 Production Flow
	5.2 Design and Evaluation
	5.3 The Gas Gauge File

	6 Example Procedures
	6.1 Choosing the Correct Chemistry
	6.2 Resetting the Pack
	6.3 Data Logging
	6.4 Seal and Unseal Process




